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Module 1: Creating and Modifying a Flyer
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Objectives (1 of 2)

• Start and exit Word

• Enter text in a Word document

• Adjust margins

• Check spelling and grammar as you work in a 

document

• Save a document

• Format text, paragraphs, and document elements

• Undo and redo commands or actions
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Objectives (2 of 2)

• Insert and format a picture

• Add a page border

• Change document properties

• Open and close a document

• Correct errors and revise a document

• Cut, copy, and paste text

• Print a document

• Use Word Help
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What Is Word?

•Microsoft Word

• A full-featured word processing app that allows you to 

create professional-looking documents and revise them 

easily

-Flyers, research papers, letters, memos, resumes, reports, 

mailing labels, newsletters

• Many features designed to simplify the production of 

documents and add visual appeal
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Project: Flyer with a Picture
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Starting and Using Word (1 of 4)

•To Start Word and Create a Blank Document

• Click the Start button on the Windows taskbar to display 

the Start menu

• Click All apps at the bottom of the left pane of the Start 

menu to display a list of apps installed on the computer or 

mobile device

• Click, or scroll to and then click, the program name (Word 

2021) in the list to run the selected program

• Click the Blank document thumbnail on the Word start 

screen to create a blank Word document in the Word 

window
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Starting and Using Word (2 of 4)

•Components of The Word Window

• Scroll Bar

• Status Bar

• Ribbon

• Tell Me Box

• Quick Access Toolbar

• Mini Toolbar and Shortcut Menus

• Key Tips

• Microsoft Account Area
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Starting and Using Word (3 of 4)

•To Display a Different Tab on the Ribbon

• Click the tab on the Ribbon to display
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Starting and Using Word (4 of 4)

•To Adjust the Margin

• Click Layout on the ribbon to display the Layout tab

• Click the MARGINS button to display the Margins gallery
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Entering Text in a Document (1 of 4)

•To Type Text

• Type the text (Wash Your Hands!) in the Word document

• To move the insertion point to the beginning of the next 

line, press the ENTER key

•To Change the Zoom to Page Width

• Click VIEW on the ribbon to display the VIEW tab

• Click the Page Width button to display the page the same 

width as the document window
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Entering Text in a Document (2 of 4)

•To Display Formatting Marks

• If the HOME tab is not the active tab, click HOME on the 

ribbon to display the HOME tab

• If it is not selected already, click the Show/Hide ¶ button 

to display formatting marks on the screen

•To Wordwrap Text as You Type

• Wordwrap allows you to type words in a paragraph 

continually without pressing the ENTER key at the end of 

each line

• (Type or copy all remaining text) 
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Entering Text in a Document (3 of 4)

•To Check Spelling and Grammar as You Type

• Type the misspelled text and then press the SPACEBAR 

so that a red wavy line appears below the misspelled 

word

• Right-click the flagged word to display a shortcut menu 

that presents a list of suggested spelling corrections for 

the flagged word

• Click the correct word on the shortcut menu

•To Insert a Blank Line

• Press the ENTER key to insert a blank line in the 

document
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Entering Text in a Document (4 of 4)

•To Save a Document for the First Time

• Click FILE on the ribbon to open the Backstage view

• Click Save As in the Backstage view to display the Save 

As screen

• Click This PC in the Save screen to display the default 

save location on the computer or mobile device

• Click the Save As screen to display the Save As dialog 

box

• Click Save to save the file
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Formatting Paragraphs and 
Characters (1 of 14)

•To Change the Document Theme

• Click Design on the ribbon to display the DESIGN tab

• Click the Themes button to display the Themes gallery

• Click the desired theme (Slate Theme) to change the 

document theme
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Formatting Paragraphs and 
Characters (2 of 14)

• To Center a Paragraph

• Click somewhere in the paragraph to be centered to position 

the insertion point in the paragraph to be formatted

• Click the Center button to center the paragraph containing the 

insertion point (headline, 1st paragraph & signature line)
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Formatting Paragraphs and 
Characters (3 of 14)

•To Select a Line

• While the pointer is a right-pointing block arrow, click the 

mouse to select the entire line to the right of the pointer
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Formatting Paragraphs and 
Characters (4 of 14)

• To Change the Font Size of Selected Text

• With the text (headline) selected, click the Font Size arrow to display 
the Font Size gallery

• Point to the desired point size in the Font Size gallery to display a 
Live Preview of the selected text at the selected point size

• Click the desired point size (36 pts) to change the font size of the 
selected text

• To Change the Font of Selected Text

• With the text selected, click the Font arrow to display the Font gallery 

• Scroll through the Font gallery, and then point to the desired font to 
display a Live Preview of the selected text in the selected font

• Click the font (Rockwell Extra Bold) to change the font of the 
selected text (headline) 
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Formatting Paragraphs and 
Characters (5 of 14)

• To Change the Case of Selected Text

• With the text (headline) selected, click the Change Case 

button to display the Change Case gallery

• Click the desired case (UPPERCASE) in the Change Case 

gallery to change the case of the selected text
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Formatting Paragraphs and 
Characters (6 of 14)

•To Apply a Preset Text Effect to Selected Text

• With the text (headline) selected, click the Text Effects 
button to display the Text Effects and Typography gallery

• Point to the desired text effect to display a Live Preview of 
the selected text with the selected text effect

• Click the text effect (Fill: White; Outline: Brown, Accent 
color 1; …) to change the text effect of the selected text

•To Shade (Applying a Background Color to) a 
Paragraph (headline) 

• Click somewhere in the paragraph to be shaded

• Click the Shading arrow [Home tab | Paragraph group] to 
display the Shading gallery 

• Click the desired shading color (row #5, col #8: Brown, 
Accent 4, Darker 25%)
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Formatting Paragraphs and 
Characters (7 of 14)

•To Change the Font Color of Selected Text

• With the text (1st paragraph, signature line) selected, 

click the Font Color arrow to display the Font Color gallery

• Click the desired font color (row #5, col #9: Red, Accent 

5, Darker25%)
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Formatting Paragraphs and 
Characters (8 of 14)

•To Change the Font Size of Selected Text

• With the text (1st paragraph) selected, click the Font Size 

arrow to display the Font Size gallery

• Click the desired font size (22 pts)

• Click anywhere in the document window to remove the 

selection from the text

•To Change the Zoom Percentage

• Repeatedly click the Zoom Out and Zoom In buttons on 

the status bar until the desired percentage is achieved
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Formatting Paragraphs and 
Characters (9 of 14)

•To Select Multiple Lines

• Move the pointer to the left of the first paragraph to be 
selected until the pointer changes to a right-pointing block 
arrow

• While the pointer is a right-pointing block arrow, drag 
downward to select all lines (all lists) that will be formatted

•To Change the Font Size of Selected Text

• With the text selected (all lists) , click the Font Size arrow 
to display the Font Size gallery

• Click the desired font size (20 pts)

• Click anywhere in the document window to remove the 
selection from the text
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Formatting Paragraphs and 
Characters (10 of 14)

•To Number a List of Paragraphs

• Select the paragraphs (How lists) to be formatted

• Click the Numbering button to place a number followed by 
a period at the beginning of each selected paragraph

•To Undo and Redo an Action

• Click the Undo button on the Quick Access Toolbar to 
reverse your most recent action

• Click the Redo button on the Quick Access Toolbar to 
reverse your most recent undo
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Formatting Paragraphs and 
Characters (11 of 14)

•To Bullet a List of Paragraphs

• Select the paragraphs (When lists) to be formatted

• Click the Bullets button to place a bullet character at the 

beginning of each selected paragraph
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Formatting Paragraphs and 
Characters (12 of 14)

•To Remove a Hyperlink

• Right-click the hyperlink (in signature line) to display a 
shortcut menu

• Click Remove Hyperlink on the shortcut menu to remove 
the hyperlink format from the text

•To Use the Mini Toolbar to Format Text (signature)

• Select the text to format to display the mini toolbar

• Make selections to font size (18 pts), color (row #5, col 
#9: Red, Accent 5, Darker 25%), or other attribute

•To Select a Group of Words

• Position the pointer to the left of the first character of the 
text (additional handwashing tips) to be selected

• Drag the pointer through the last character in the text to 
be selected
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Formatting Paragraphs and 
Characters (13 of 14)

•To Underline Text

• With the text selected (in the end of last slide), click the 
Underline button to underline the selected text

•To Italicize Text

• Click somewhere in the word to be italicized to position 
the insertion point in the word to be formatted

• Click the Italic button to italicize the word (1st paragraph: 
prevent) containing the insertion point

•To Select Nonadjacent Text

• Select the first word to format, hold down CTRL select the 
next word (the first words of the numbered list) 
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Formatting Paragraphs and 
Characters (14 of 14)

•To Bold Text

• With the text selected (end of last slide), click the Bold 

button to bold the selected text

•To Save an Existing Document with a Different 

File Name

• Click File on the ribbon to open Backstage view

• Click Save As in Backstage view to display the Save As

• Type the new file name

• Click the Save button
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Inserting and Formatting a Picture in a 
Word Document (1 of 3)

•To Insert a Picture from a File

• Position the insertion point where you want to insert the 

picture (between the How and When lists)

• Click INSERT on the ribbon to display the INSERT tab

• Click the PICTURES button to display the Insert Picture 

dialog box

• Navigate to the picture location

• Select the picture you wish to insert

• Click the Insert button to insert the picture at the location 

of the insertion point in the document
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Inserting and Formatting a Picture in a 
Word Document (2 of 3)

•To Change the Zoom to One Page

• Click View on the ribbon to display the View tab

• Click the ONE PAGE button to change the zoom to one 

page

•To Resize an Object Proportionally

• Drag one of the sizing handles to increase or decrease 

the size of the graphic until the flyer fits the whole page
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Inserting and Formatting a Picture in a 
Word Document (3 of 3)

• To Apply a Picture Style

• Be sure the picture still is selected

• Click PICTURE TOOLS FORMAT tab on the ribbon

• Click the MORE button in the Picture Styles gallery to expand the 
gallery

• Click the desired style (#15, Snip Diagonal Corner, White) in the 
Picture Styles gallery to apply the style to the selected picture

• To Apply Picture Effect

• With the picture still selected, click the PICTURE EFFECTS button to 
display the Picture Effects menu

• Point to the desired effect category (Shadow)

• Click the desired picture effect in the gallery to apply the selected 
picture effect (Perspective: Upper Left)
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Enhancing the Page (1 of 5)

•To Change Theme Colors

• Click DESIGN on the ribbon to display the DESIGN tab

• Click the COLORS button [Design tab | Document 

Formatting grp] to display the Colors gallery

• Click the desired color to change the document theme 

colors (Blue II)

-31-



Enhancing the Page (2 of 5)

•To Add a Page Border

• Click the PAGE BORDERS button [Design tab | Page 

Background grp] to display the Borders and Shading 

dialog box

• Click the desired border setting (Box)

• Click the desired border style (the 3rd from the bottom)

• Click the Color arrow to display a color palette

• Click the desired color (row #5, col #7: Turquoise, 

Accent 3, Darker 25%)

• Click Width arrow to change width of page border (3 pt) 

• Click the OK button to add the border to the page
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Enhancing the Page (3 of 5)

•To Change Spacing before and after 

Paragraphs

• Position the insertion point in the paragraph to be 

adjusted (How?  ;  When?  ; signature line)

• Click LAYOUT on the ribbon to display the Layout tab

• Change the values in the Spacing Before and Spacing 

After boxes (0 pt & 0 pt;  0 pt & 0 pt;  12 pt & 8 pt)
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Enhancing the Page (4 of 5)

•To Change the Document Properties

• Click File on the ribbon to open the Backstage view and 

then click the Info tab

• Click to the right of the Comments property (add info)

• Click the Back button in the upper-left corner of the 

Backstage view to return to the document window

•To Save an Existing Document with the Same 

File Name

• Click the SAVE button on the Quick Access Toolbar to 

overwrite the previously saved file in the same location it 

was saved previously
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Enhancing the Page (5 of 5)

•To Close a Document

• Click FILE on the ribbon to open Backstage view

• Click CLOSE in Backstage view to close the currently 

open document
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Correcting Errors and Revising a 
Document (1 of 6)

•To Open a Document

• Click FILE on the ribbon to open the Backstage view and 
then click Open in the Backstage view to display the Open 
screen

• Click the Browse to display the Open dialog box

• If necessary, navigate to the location of the file to open

• Click the file to open

• Click the Open button to open the file 

•To Insert Text in an Existing Document

• Scroll through the document and then click to the left of 
the location of text to be inserted to position the insertion 
point (apply soap)

• Type the new text (then)
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Correcting Errors and Revising a 
Document (2 of 6)

•To Delete or Cut Text

• Double-click the word to be selected

• Click the CUT button

•To Copy and Paste

• Select the item to be copied

• Click the COPY button to copy the selected item in the 
document to the Office Clipboard

• Position the insertion point at the location where the item 
should be pasted

• Click the PASTE button to paste the copied item in the 
document at the location of the insertion point
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Correcting Errors and Revising a 
Document (3 of 6)

•To Display the Paste Options Menu

• Click the PASTE OPTIONS Button to display the Paste Options 

menu

•To Move Text

• Select the text to be moved 

• With the pointer in the selected text, press and hold down the 

mouse button, which displays a small dotted box with the pointer

• Drag the insertion point to the location where the selected text is 

to be moved

• Release the mouse button to move the selected text to the 

location of the dotted insertion point

• Click anywhere in the document window to remove the selection
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Correcting Errors and Revising a 
Document (4 of 6)

•To Switch to Read Mode

• Click the READ MODE button on the status bar to switch 

to Read mode

•To Switch to Print Layout View

• Click the PRINT LAYOUT button on the status bar to 

switch to Print Layout

•To Print the Document

• Click Print in the Backstage view to display the Print 

screen and a preview of the document

• Verify the printer, and click print
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Correcting Errors and Revising a 
Document (5 of 6)

•To Use the Search Box

• Type the search text (“margins”) in the Search box

• Point to the desired submenu to display the various option

• Click an empty area of the document window to close the 

search results

•To Use the Help Pane

• Click HELP on the ribbon to display the Help tab

• Click the HELP button to display the Help pane

• When you are finished, click CLOSE
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Correcting Errors and Revising a 
Document (6 of 6)

•To Exit Word

• Click the CLOSE button in the upper-right corner of Word 

window
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